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Document Disclaimer
The information in this document has been carefully checked and is believed to be reliable. 
However, no responsibility can be assumed for inaccuracies that may not have been 
detected. LeCroy reserves the right to revise the information in this document without 
notice or penalty.

Changes or Modifications
Any change or modification not expressly approved by LeCroy voids the user’s authority 
to operate this equipment.

Trademarks and Servicemarks
LeCroy, Advisor, USBTracer, USBTrainer, USBMobile, USBMobileHS, and BusEngine 
are trademarks of LeCroy. 

Microsoft, Windows 98SE, Windows Me, Windows 2000, Windows XP, and Windows NT 
are registered trademarks of Microsoft Inc.

All other trademarks are property of their respective companies.

Copyright
Copyright © 2004, LeCroy; All Rights Reserved. This document may be printed and 
reproduced without additional permission, but all copies should contain this copyright 
notice. 

FCC Conformance Statement
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user will be required to correct 
the interference at his own expense. The end user of this product should be aware that any 
changes or modifications made to this equipment without the approval of LeCroy could 
result in the product not meeting the Class A limits, in which case the FCC could void the 
user's authority to operate the equipment.

EU Conformance Statement
This equipment complies with the EMC Directive 89/336/EEC and the Low Voltage 
Directive 73/23/EEC, and their associated amendments for Class A Information 
Technology Equipment.  It has been tested and found to comply with EN55022:1998 Class 
A (EN61000-3-2:1998, EN61000-3-3:1995) and EN55024:1998 (EN61000-4-2:1998, 
EN61000-4-3:1996, EN61000-4-4:1996, EN61000-4-5:1996, EN61000-4-6:1997, 
EN61000-4-11:1998), and EN60950:1999.  In a domestic environment this product may 
cause radio interference in which case the user may be required to take adequate measures.

Part number: 730-0049-00
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1.  Overview
The LeCroy USBMobileHS USB Hi-Speed Analyzer is a portable, PC Card 
based, bus and protocol analyzer that accurately and efficiently debugs, tests 
and verifies Low, Full, and Hi-Speed USB semiconductors, devices, 
software and systems. USBMobileHS features the CATC Trace software, 
the de-facto standard for recording and analyzing USB protocol traffic. The 
CATC Trace simplifies the overall debug process by using collapsible, 
color-coded schemes to represent the USB Packet, Transfer and Transaction 
layers. Its native On-The-Go (OTG) support automatically detects, decodes, 
and displays the HNP and SRP protocols, including VBus pulsing. The 
USBMobileHS builds upon LeCroy's experience and knowledge of the 
needs of the USB development and test communities. The result is a USB 
bus and protocol analyzer with unprecedented functionality, unparalleled 
flexibility, and uncompromising user friendliness.

1.1  Event Triggering
For efficient development of USB systems, it is critical that users are able 
to extract important information from a crowded stream of bus traffic, and 
accurately identify and selectively record information that is of most 
interest. The Events and Action fields for trigger set-up is intuitive and 
graphical, thus making pre-recording set-up time efficient. 

USBMobileHS provides real-time hardware triggering on the critical 
components of USB. Users can custom-configure and control order of 

Features Benefits

Low power, 16 bit, Type II 
PC Card Design

Personal analyzer.  Portable operation with any notebook PC

CATC Trace software 
display

De-facto industry standard speeds up interpretation and debug of 
USB traffic.  Compatible with LeCroy USBMobile, Inspector, 
Chief, Advisor, and USBTracer/Trainer

OTG (On-The-Go) Support Record and analyze HNP and SRP including the capturing of 
VBus pulses 

Trace Navigator Define areas of interest and "shrink" viewable Trace to areas of 
most importance

Advanced Triggering Isolate important traffic, specific errors or data patterns 

Hardware Filtering Faster analysis by removing non essential fields from the trace

Intelligent Reporting Quickly identify and track error rates, abnormal bus or timing 
conditions

Sophisticated Viewing View Packet, Transaction and Transfer layers of the USB protocol

Downloadable trace viewer 
software

Share and annotate trace recordings within a development team
 1
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events selected for triggering. The count and sequence options define the 
rules for data recording sessions. There are two Counters, Filter Out/In and 
a Restart option that causes sequencing and counting to start again. Any 
sequence can include up to seven events of any type. 

Users can adjust the depth of the recording memory - up to 64 Mbytes - and 
determine where in the recording the trigger is located.

1.2  On The Go Support
The USBMobileHS supports OTG (On-The-Go) capabilities.  OTG is an 
emerging standard in the USB specifications that allows peer-to-peer 
connectivity among USB devices and provides a standard USB connection 
among portable devices.  The analyzer identifies both the HNP (Host 
Negotiation Protocol) and SRP (Session Request Protocol) occurrences, 
searches for Host A or B, and identifies timing anomalies during HNP and 
SRP protocols.
2
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1.3  The CATC Trace
The CATC Trace's ability to extract critical information quickly and 
intuitively from a crowded stream of bus traffic is unparalleled. The ability 
to accurately identify and isolate very specific packets is vital to speeding 
debug and development time. Powerful Search and Find options allow users 
to quickly get to specific packets, errors and any data type within a trace file. 
With filter and hide commands, the CATC Trace removes irrelevant data 
from the Trace for efficient viewing.

1.4  USBMobileHS System Components
The LeCroy USBMobileHS 2.0 Hi-Speed Protocol Analyzer package 
includes the following items:

• One LeCroy USBMobileHS analyzer
• One 1-meter A-B cable (standard A plug to mini B plug)
• One 1-meter A-B cable (mini A plug to mini B plug)
• One 15-centimeter On the Go (OTG) adaptor (standard A receptacle to 

mini A plug)
• LeCroy USBMobileHS software program installation CD
• Product Documentation
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1.5  USB Specification
Please refer to the Universal Serial Bus Specification, version 2.0 for details 
on the protocol. The USB specification is available from the USB 
Implementers Forum (USB-IF) at

1.6  Features

General
• Fully compliant with USB 2.0 specification
• Supports Full-Speed, Low-Speed, and Hi-Speed USB
• User friendly "CATC Trace" Interface that displays bus traffic using 

color and graphics
• Trace Viewer available as free non-recording, view-only software
• Three year warranty and hot-line customer support

Physical Components
• PC-Card form factor: Personal analyzer. Low-power, portable operation 

with any notebook PC. 
• Two Mini AB USB ports and cables: Designed to reduce bulk and 

maintain portability and compact size. 
• 64MB of physical recording memory

Recording Options
• Versatile triggering - bit-wise value and mask data patterns up to sixteen 

bytes wide for Setup transactions and data packets.
• Triggering on new High-speed PIDs and split transaction special tokens 

(ERR, SPLIT, PING, NYET, DATA2, and MDATA).
• CATC Trace displays and enumerates High-speed Micro Frames.
• Three forms of triggering: Snapshot, Manual and Event.
• Transaction sequencer allows triggering on a token qualified by a data 

pattern and /or specific handshake or alternately transactions can be 
filtered (i.e., NAK’d transactions).

• Advanced triggering with event counting and sequencing.

USB Implementers 
Forum
1730 SW Skyline Blvd. 
Suite 203
Portland, OR 97221

Tel: +1/503.296.9892
Fax: +1/503.297.1090
Web: http://www.usb.org/
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• Triggering on multiple error conditions - PID bad, bit stuffing bad, CRC 
bad, end-of-packet bad, babble, loss of activity, frame length violation, 
time-out or turn-around violation, data toggle violation, Token, Bus 
Conditions, Data Length, excessive empty frames.

• Real-time traffic capture filtering and data packet truncation variable up 
to 256 bytes. 

• Adjustable buffer size from 0.4 MB to 64 MB.

Display Options
• Utilizes "CATC Trace" graphical display of bus packets, transactions, 

split transactions and transfers.
• Numerous packets and transactions can be grouped under a single 

transfer while quickly decoding all essential information.
• Decoding of split transactions up and down stream of a transaction 

translator is accomplished with a special hierarchical view.
• Variety of reports provided to summarize key statistics and conditions of 

interest with the ability to jump to the selected item in the trace display.
• Flexible input signaling can be recorded with the CATC Trace.
• Trace Viewer is backward compatible with USBTracer, USBMobile, 

Advisor, Chief, Inspector and Detective™ trace files.
• User-friendly trigger position indicated by different colors of pre- and 

post-trigger packet color.
• Markers can be set to assist with navigation and time calculations. 
• Hide start-of-frame (SOF) packets as well as any packet or transaction.
• Search for a specific PID.
• Detects & alerts the user to every potential bus error, protocol violation, 

& combinations thereof.
• High resolution, accurate time stamping of bus packets, timing 

measurement and analysis functions.
• Extensive search and packet hiding capabilities.
• Comprehensive device class decoding plus user defined protocol 

decoding.

Note Refer to Readme.txt on your installation disks for the latest 
information on features. 
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1.7  Specifications

Package
Dimensions: 5.3 x 2.1 x 0.4 inches

(135 x 54 x5 millimeters)
Weight: 1.8 ounces

(51 grams)

Hardware Interface
Connectors: Standard 16-bit Type II PC Card

Mini A-B Receptacles

Power Consumption
Idle: 500 milliamps (typical)
Active: 560 milliamps (typical)

Environmental Conditions
Operating Range: 0 to 55°C (32 to 131°F)
Storage Range: -20 to 80°C (-4 to 176°F)
Humidity: 10 to 90%, non-condensing

Recording Memory Size
64 MB

Host Compatibility
Works with any PC equipped with a functioning PCMCIA slot and running 
Microsoft Windows 98SE, Windows Me, Windows 2000, and XP operating 
systems.

Product Warranty
LeCroy provides a three-year limited warranty on its products.
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2.  Installation 
USBMobileHS is controlled through a personal computer PCMCIA slot. It 
can be used with portable computers for field service and maintenance as 
well as with desktop units in a development environment. 

Figure 1:  USBMobileHS Connection

USBMobileHS provides on-the-fly detection of and triggering on such 
events as specific user-defined bus conditions, packets matching any Packet 
Identifier (PID), packets matching a Token or Setup transaction, data 
patterns, and errors and bus conditions. Whether recording manually or with 
a specified Trigger condition, USBMobileHS continuously records the bus 
data in a wrap-around fashion until manually stopped or until the Trigger 
Event is detected and a specified post-Trigger amount of bus data is 
recorded.

Upon detection of a triggering event, the analyzer continues to record data 
up to a point specified by the user. Real-time detection of events can be 
individually enabled or disabled to allow triggering on events as they 
happen. This includes predefined exception or error conditions and a 
user-defined set of Trigger events. 
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The USBMobileHS software provides powerful search functions that enable 
investigation of particular bus events and allow the software to identify and 
highlight specific events. In addition to immediate analysis, you can print 
any part of the data. Use the Save As feature to save the data on disk for later 
viewing. The program also provides a variety of timing information and 
data analysis reports.

2.1  USB Test Ports
Connect a host to one of the mini a-b receptacles (use an adaptor if 
necessary), and connect your device to the other. It does not matter which 
receptacle you plug into.

Note The USBMobileHS USB 2.0 Classic Analyzer is not a hub 
device; it connects to a USB branch by inserting a non-intrusive, 
high impedance tap. Because of the poor signal quality in the 
middle of a USB cable, LeCroy recommends using the shortest 
possible cables so that the total length of both cables together is 
less than 6 feet. The USB cables provided with your analyzer 
meet this requirement. When longer cables are used, the analyzer 
might record incorrect data.

2.2  Analyzer PC Requirements
The following is a list of recommended configuration for the host machine 
that runs the USBMobileHS application and that is connected to the 
USBMobileHS Analyzer: 
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• Microsoft Windows 98SE, Me, 2000, or XP. The USBMobileHS 
application can be used on machines with Windows NT 4.0 to view 
trace files. Microsoft Internet Explorer, version 5 or newer.

• For optimum performance, use processors of Intel's 
PentiumIII/Pentium4 family, AMD’s Athlon/Duron family, or 
other compatible processors with clock speed of 500mHz or higher 
(Processors of Intel’s Pentium II/Celeron family or AMD’s K6 
family with clock speed of 300mHz is a minimum).

• For the best performance, it is recommended to have a minimum of 
128MB of RAM.

• At least 20MB of free hard disk space is required for the 
USBMobileHS installation. Additional disk space is needed for 
storing the recorded data in files during the recordings process (can 
be as much as 50MB when recording a full buffer size).

• Display: Resolution of 1024 x 768 with at least 16-bit color is 
recommended (resolution of 800 × 600 with 16-bit color is a 
minimum).

2.3  Software Installation
Step 1 Insert the USBMobileHS CD-ROM into your computer.

Step 2 Click Install Software when the Auto-Run program is 
displayed.

Step 3 Follow the installation instructions on your screen. 

The CATC Install Wizard automatically installs the necessary files to the 
computer’s hard drive. The software is installed in the C:\Program 
Files\LeCroy\USBMobileHS directory unless you specify otherwise. Follow 
the installation instructions on your screen.

2.4  Hardware Installation
USBMobileHS components and software are easily installed and quickly 
ready to run on most personal computer systems. You can begin USB 
recordings after following these initial steps. 

Step 1 Insert the CD-ROM.

Step 2 Click NEXT when you see the Add New Hardware Wizard 
window.

Step 3 Follow the on-screen Plug and Play instructions under 
Windows.
 9



USBMobileHS Analyzer User ManualLeCroy SW Version 2.15
Step 4 Click Finish when you see the message that says "Windows has 
finished installing the software that your new hardware requires" 
and the file "USBMobileHS.inf" has been installed on your host 
PC. 

Step 5 Run the program setup and follow the on-screen instructions.

Launch the LeCroy USBMobileHS program from the LeCroy 
programs group.  The main software screen opens: 

Step 6 From the Help menu, select About USBMobileHS ...

If the information below is present, you can record a trace:

• USBMobileHS Software Version

• USBMobileHS Driver Version

• BusEngine Version

• Unit Serial Number
10
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2.5  Your First USB Recording
After installing and launching the software, you can test USBMobileHS by 
performing the following steps. 

Step 1 Connect a USB cable to each of the two connectors on the 
USBMobileHS module, and then connect the other ends to the 
USB device under test and USB host system.

Step 2 Select Recording Options under Setup on the Menu Bar.

Step 3 Select the General tab.

The following dialog box will open showing factory default settings 
such as “Snapshot” and 1 Mbyte buffer size. For your first recording, 
you can leave these settings unchanged.

Step 4 Click OK to activate the recording options you selected.

Step 5 Turn on the USB devices that are to be tested and cause them to 
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generate USB traffic.

Step 6 Click  on the Tool Bar.

USBMobileHS starts to record the USB traffic immediately. After 1 
Mbyte of traffic is recorded, the analyzer will upload the data and 
display the packets in the trace window.

Step 7 If you wish to terminate the recording before the snapshot 
automatically completes, click  on the Tool Bar.

When the recording session is finished, the traffic is uploaded from 
the analyzer to the hard drive on your PC as a file named data.usb 
or whatever name you assigned as the default filename. While the 
file is being uploaded, you should see a brown progress bar at the 
bottom of the screen. When the bar disappears, it indicates that the 
data has been uploaded to disk.

Step 8 To save a current recording for future reference, select Save As 
under File on the Menu Bar.

OR

Click  on the Toolbar.

The standard Save As screen appears.

Step 9 Give the recording a unique name and save it to the appropriate 
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directory.

Capturing Your First CATC Trace
After a moment, the recording will terminate and the results will display. 

Trace View Features
• The USBMobileHS packet view display makes extensive use of 

color and graphics to fully document the captured traffic.

• Packets are shown on separate rows, with their individual fields 
both labeled and color coded. 

• Packets are numbered (sequentially, as recorded), time-stamped 
(with a resolution of 16.67 ns), and highlighted to show the 
transmitted speed (low-speed or full-speed).

• Display formats can be named and saved for later use. 

• Pop-up Tool Tips annotate packet fields with detailed 
information about their contents

• Data fields can be collapsed to occupy minimal space in the 
display (which can in turn be zoomed in and out to optimize 
screen utilization). 
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The display software can operate independent of the hardware and so can 
function as a stand-alone Trace Viewer that may be freely distributed.
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3.  Updates
From time to time as modifications are made to the USBMobileHS 
Hi-Speed USB Analyzer, it is necessary to update the analyzer for optimal 
performance. 

3.1  Software, Driver, and BusEngine Revisions
The Readme.txt file on the first installation disk and in the installed 
directory gives last-minute updates about the current release. 

Once the analyzer has completed the self diagnostics and is connected to the 
PC, you can check the latest revision of the software and BusEngine by 
selecting About USBMobileHS… from the Help menu.  

About USB USBMobileHS details revisions of the following software and 
hardware:

• USBMobileHS Software Version

• USBMobileHS Driver Version

• BusEngine Version

• Unit Serial Number

Note When contacting LeCroy for technical support, please have 
available all the revisions reported in the About USB 
USBMobileHS window.
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3.2  Software Updates
When a new software release is available, it is posted on the Support page 
of the LeCroy website at www.lecroy.com/support.html.

To update the software,

Step 1 In the About USBMobileHS screen, verify which version of 
USBMobileHS Software you are currently running.

Step 2 Find the latest released software version on the LeCroy 
website under Support.

If you are running the latest version of the software, no 
further action is needed. 

If you are not running the latest version, continue to Step 3.

Step 3 Download the Zip files from the website. 

Step 4 Unzip the files into your choice of directory.

Step 5 Click Start, then Run, and browse to where you unzipped the files.

Step 6 Select the program named Setup and click Open.

Step 7 Click OK to run the Setup and begin the installation.

Step 8 Follow the on-screen instructions to complete the 
installation.

Step 9 Read the Readme file for important information on changes 
in the release.

3.3  BusEngine and Driver Updates
The Bus Engine and driver updates are done automatically during software 
installation.  No user interaction is necessary or possible.
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4.  Software Overview
The USBMobileHS software is an application that may be used with or 
without the Analyzer. When used without an Analyzer, the program 
functions in a Trace Viewer mode to view, analyze, and print captured 
protocol traffic from USBMobileHS Analyzers.  The software will also 
allow you to view trace files created by the LeCroy USBTracer, 
USBMobile, Advisor, Chief, Detective, and  Inspector. Opening a file 
created with either of these Analyzers displays a screen asking if you want 
to convert the old file to the new format under the name convert.usb.

When the program is used with the USBMobileHS Analyzer attached to the 
computer, you can monitor and analyze the activity of your USB branch 
from either of the USB ports on the front of the Analyzer.

4.1  Starting the USBMobileHS Program
To starting the USBMobileHS Program:

Step 1 Click Start > Programs > LeCroy > LeCroy 
USBMobileHS.
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4.2  Tool Tips 
Tool tips provide useful information about fields and 
buttons.  In some cases, tool tips spell out acronyms 
used in trace fields.  In other cases, tool tips provide substantial amounts of 
additional information. To display a tool tip, position the mouse pointer over 
an item.

4.3  Menus
The following table describes the menus within the application.  Note that 
some menus are context-sensitive...

Menu Function

File
Open… Opens a file.
Close Closes the current file.
Save As… Saves all or a specified range of packets from the current file with a 

specified name.
Print… Prints part or all of the current traffic data file.
Print Preview Produces an on-screen preview before printing.
Print Setup… Sets up your current or new printer.
Edit Comment… Creates or edits the Trace file comment field.
Export>>

 Packets to Text (Packet 
View Format)

 Packets to .CSV 
(Comma Separated 
Values for Excel, etc.) ...

Packets to Host Traffic 
Generator Text File 
(.utg) ...

Packets to Device 
Emulation Traffic 
Generation Text File 
(.utg) ...

Data

Saves all or part of a trace to a text file or generator file.

Packets to Text (Packet View Format)- Saves trace as text file.

Exports traffic data to a file format compatible with spreadsheet 
and database applications.

Saves trace as script file that can be used by the LeCroy 
USBTrainer traffic generator to generate host-side traffic.

Exports packets to Device Emulation files for use on USBTrainer.  
This option does not export transactions.
 

Data - Allows Transfer data to be exported as text or binary file.
Import Imports data from a .vcd file.
Compare Endpoint Data This command allows the user to select two endpoints of different 

directions with same address and verify that the data OUT/IN is 
identical to the data IN/OUT from the other endpoint.  This 
command is useful when running echo-types of tests for data 
integrity.  This command is present in the menu only when a trace 
file (.usb) is open.

Last File Lists the last files that were opened.
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Setup
Display Options… Provides the  control of various display options such as color, 

formats, and filters.
Recording Options… Provides setup options for recording, triggering events and filtering 

events.

Record
Start Causes the Analyzer to begin recording USB activity.
Stop Causes the Analyzer to stop recording.
Upload Again If the previous upload was only partially uploaded, use this to 

upload a different portion of the captured trace. 
Manual Trigger Causes a trigger in a trace. This button is only available in Manual 

Trigger mode. 

Report
File Information Displays information about the recording such as the number of 

packets and triggering setup.
Error Summary Summarizes the errors throughout the recording. Allows for fast 

navigation to packet with errors.
Timing Calculation Calculates timing between two packets and bus utilization.
Traffic Summary Summarizes the numbers and types of packets, transactions, split 

transactions, and transfers that occurred in the open trace.
Bus Utilization Opens a window that displays graphs of bus utilization data.  Once 

the window is open, the Bus Utilization menu will let you access 
the following sub-menu options:  Hide, Save, Send, Print, Full 
Screen, View Options, Set Range, Synchronize, Graph Areas.

Search
Go to Trigger Positions the display to show the first packet that follows the trigger 

event.
Go to 
Packet/Transaction/Tran
sfer ...

Positions the display to the indicated packet/transaction/transfer 
number.

Go to Marker » Positions the display to the selected marked packet.
Go to » Enables quick searching for specific events using a cascade of 

pop-up windows.
Find Allows complex searches on multiple criteria.
Find Next Repeats the previous Find operation.
Search Direction Allows the search direction to be changed from forward to 

backwards or vice versa.

View
Toolbars Displays list of available toolbars.
Status Bar Switches display of the Status Bar on or off.
Zoom In Increases the size of the displayed elements.
Zoom Out Decreases the size of the displayed elements.
Wrap Wraps displayed packets within the window.
Hide SOF’s Hides Start of Frames.

Menu Function
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View Options
You can hide, display or reset 
toolbars by selecting View > Tool 
bars from the menu bar.

Resetting the Tool bar
From time to time (such as 
following a software upgrade) it is 
possible for the buttons on the 
toolbar to not match their intended 
function.  You can reset the toolbar by performing the following steps:

Step 1 Select View >Tool bars from the menu bar.

Hide NAK’s Hides NAK’ed Transactions.
Hide Devices Hides packets belonging to specified devices by address and 

endpoint.
Hide Chirps Hide the Chirp-K and Chirp-J Bus conditions. These are recorded 

only in USBMobileHS. 
Packet Level Displays Packets.
Transaction Level Displays Transactions.
Split Transaction Level Displays Split Transactions.
Transfer Level Displays Transfers.
Refresh Decoding Performs a re-analysis and re-decoding of all of the transactions in 

the trace

Window
New Window Switches display of the Tool Bar on or off.
Cascade Displays all open windows in an overlapping arrangement.
Tile Horizontal Arranges multiple trace windows as a series of strips across the main 

display area.
Tile Vertical Displays all open windows in a side-by-side arrangement.

Arrange Icons Arranges minimized windows at the bottom of the display.

Windows ... Displays a list of open windows.

Help
Help Topics ... Displays online help.
Update License... Opens a dialog box for updating your LeCroy license. 
Display License 
Information...

Displays information related to licensing.

About USB 
USBMobileHS ...

Displays version information about USB USBMobileHS.

Menu Function
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Step 2 Select Customize from the sub-menu.

The following dialog box will open. 

Step 3 Select the Toolbars tab.

The following dialog box will open.

Step 4 Click the Reset All button.

The toolbar resets to the factory defaults.
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Tool Bar

The Tool Bar provides quick and convenient access to the most popular 
USBMobileHS program functions. Tool tips describe the functionality of 
each icon and menu item as the mouse arrow is moved over the icon/item. 

Open file Hide Chirps

Save As Assign High Level Decodes

Preview Find 

Print… Find Next

Setup Record Options File Information Report

Setup Display Options Error Report

Start Recording Timing and Bus Usage Calculations

Stop Recording Traffic Summary

Manual Trigger Bus Utilization

Zoom In Open the Navigator bar

Zoom Out Display Packets

Wrap Display Transactions

Hide SOFs Display Split Transactions

Hide NAK’ed transactions Display Transfers

Hide Devices
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4.4  Status Bar
The Status Bar is located at the bottom of the main display window. 
Depending on the current activity, the bar can be divided into as many as 
four segments.

Recording Progress
When you begin recording, the left-most segment of the Status Bar displays 
a Recording Progress Indicator.  

As recording progresses, the Progress Indicator changes to reflect the 
recording progress graphically.  In the Progress Indicator, a black vertical 
line illustrates the location of the Trigger Position you selected in Recording 
Options:

— Pre-Trigger progress is displayed in the field to the left of the 
Trigger Position in the before-Trigger color specified in the 
Display Options. 

— When the Trigger Position is reached, the progress indicator 
wiggles as it waits for the trigger. 

— After the trigger occurs, the field to the right of the Trigger 
Position fills in the after-Trigger color specified in the Display 
Options. 

— When recording is complete, the upper half of the progress 
indicator fills in white, indicating the progress of the data 
upload to the host computer.

You should be aware of two exceptional conditions: 

• If a Trigger Event occurs during the before-Trigger recording, the 
before-Trigger color changes to the after-Trigger color to indicate 
that not all the expected data was recorded pre-Trigger. 

• When you click Stop before or after a Trigger Event, the Progress 
Bar adjusts accordingly to begin uploading the most recently 
recorded data.
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The Progress Bar fills with color in proportion to the specified size and 
actual rate at which the hardware is writing and reading the recording 
memory. However, the Progress Indicator is normalized to fill the space 
within the Status Bar.

Recording Status
During recording, the current Recording Status is displayed in the next 
segment. When you activate the Record function, this segment flashes one 
of the following messages (depending on the selected Recording Options):

— Trigger?

— Triggered!

— Uploading

After recording stops, 

— The flashing message changes to Uploading data–x% done 
(x% indicates the percentage completion of the data 
uploading process). 

— The traffic data is copied to disk into the default file data.usb 
(or whatever file name you have specified in the Recording 
Options dialog box.)

To abort the upload process,

• Press Esc on your keyboard or click  in the Tool Bar. 

You are asked if you want to keep or discard the partially 
uploaded data.

Note: While uploading is in progress, clicking the Stop button again brings 
up a dialog with four options:

• Full Buffer/Upload Selection - this option lets you decide how 
much of the buffer to upload.  The slide bar lets you set the range 
to be uploaded.

• Stop - Ends the upload process and preserves whatever part of the 
recording has been uploaded.

• Continue - Resumes the upload process.

• Flush - Empties the uploaded trace from the current file.
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The Partial Upload button is enabled when you have partially uploaded data. 
When you click this button, a dialog box appears that gives you options on 
what portion of data you want to upload again. 

When the data is saved, the Recorded Data file appears in the main display 
window and the Recording Status window is cleared.

• If the recording resulted from a Trigger Event, the first packet 
following the Trigger (or the packet that caused the Trigger) is 
initially positioned second from the top of the display.

• If the recording did not result from a Trigger Event, the display 
begins with the first packet in the traffic file.

Recording Activity
During recording, the fourth segment from the left of the Status Bar displays 
Recording activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity 
being recorded.  If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Note: If packets are filtered from the recording or data are truncated, the 
recording activity is reduced.

Search Status
The rightmost segment displays the current search direction: Fwd (forward) 
or Bwd (backward). Change the search direction from the Search Menu or 
double-click in the Search Status segment.   
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4.5  Navigation Tools
You can zoom in and out, and wrap packets/transactions/transfers to fit 
within the screen using the following buttons:

Zoom In
Zoom In increases the size of the displayed elements, allowing fewer (but 
larger) packet fields per screen. 

• Click  on the Tool Bar.

Zoom Out
Zoom Out decreases the size of the displayed elements, allowing more (but 
smaller) packet fields per screen. 

• Click  on the Tool Bar.

Wrap
Select Wrap to adjust the Trace View so that packets fit onto one line. If a 
packet is longer than the size of the window, the horizontal scroll bar can be 
used to see the hidden part of the packet.

• Click  on the Tool Bar or select Wrap under View on the 
Menu Bar.

4.6  USBMobileHS Analyzer Keyboard Shortcuts
Several frequently-used operations are bound to keyboard shortcuts. 

Table 1: Keyboard Shortcuts
Operation Key Combination

Trace Navigation

Find Next F3

Search Backwards Ctrl+B

Search Forwards Ctrl+F

Jump to First Packet Ctrl+Home

Jump to Last Packet Ctrl+End

Goto Any Error Shift+E

Goto Channel 0 Ctrl+Shift+0

Goto Channel 1 Ctrl+Shift+1

View Packets CTRL-1  
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View Transactions CTRL-2  

View Split Transactions CTRL-3 

View Transfers CTRL-4 
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PID

Goto ACK Shift+A

Goto DATA0 Shift+0

Goto DATA1 Shift+1

Goto DATA2 Shift+2

Goto DATAx Shift+D

Goto IN Shift+I

Goto MDATA Shift+M

Goto NAK Shift+N

Goto NYET Shift+Y

Goto OUT Shift+O

Goto PING Shift+G

Goto PRE/ERR Shift+P

Goto SETUP Shift+S

Goto SOF Shift+F

Goto SPLIT Shift+X

Goto STALL Shift+L

Bus Conditions

Goto Reset Shift+T

Goto Resume Shift+6

Goto SE0 Shift+Z

Goto SE1 Shift+7

Goto Keep-Alive Shift+5

Goto Suspend Shift+U

Goto Chirp Shift+C

Goto Full Speed J Shift+J

Goto Full Speed K Shift+K
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OTG

Goto SRP Ctrl+Q

Goto HNP Shift+H

Goto VBus Voltage Change Shift+V

Goto OTG Host A Ctrl+Shift+A

Goto OTG Host B Ctrl+Shift+B

Misc.

Marker Menu Ctrl+M

Open File Ctrl+O

Print… Ctrl+P

Record Ctrl+R

Stop Recording Ctrl+T

Open Display Options dialog Ctrl+Shift+D

Open Recording Options dialog Ctrl+Shift+R

Hide SOFs Ctrl+Shift+S

Hide NAKs Ctrl+Shift+N

Hide Chirps Ctrl+Shift+C
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5.  Recording Options
Use Recording Options to create and change various features that control 
the way information is recorded by the USBMobileHS Analyzer. 

To open the Recording Options menu,

• Select Recording Options under Setup on the Menu Bar

OR

• Click  on the Tool Bar.

You see the Recording Options window:

The Recording Options window always opens with the General tab 
showing. 
 31



USBMobileHS Analyzer User ManualLeCroy SW Version 2.15
5.1  General Recording Options
The General Recording Options allow you to select or adjust the recording 
type, the buffer size, the amount of post-trigger recording, and the trace 
filename and path.

Recording Type
The Recording Type box presents three options that allow 
you to set how USBMobileHS begins and ends a 
recording.  The options are:  Snapshot, Manual Trigger, 
and Event Trigger.

Snapshot
A Snapshot is a fixed-length recording whose size is determined by the 
"Buffer Size" box in the Recording Options dialog or by a manual click of 
the Stop button.  Recording begins when  is clicked and ends when 
either the selected buffer size  is  filled  or  the    button is pressed.  

Manual Trigger
A Manual Trigger is a recording whose trigger point is caused by pressing 
the trigger button on the front panel.

Recording begins when you click  on the Tool Bar. Recording continues 
in a circular manner within the limits set by the buffer size. Recording ends 
when   is clicked on the Tool Bar or after post-trigger memory has been 
filled following depression of the trigger button on the front panel.

Event Trigger
Recording begins when you click  on the Tool Bar.

Recording continues in a circular manner within the limits set by the buffer 
size until an event is detected that meets the Trigger conditions specified in 
the Triggering Options and the defined amount of data has been recorded 
after the Trigger Event.

Options
• Truncate Data Fields: Allows data fields to be truncated during 

recording in order to save Analyzer memory and allow recording 
of more packets.  Enter a minimum data length value in the box 
marked "Bytes."  USBMobileHS will truncate the data to the 
stated value or slightly larger.

Note: Truncation of data may cause incorrect transaction or transfer 
decoding.  
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• Beep When Trigger Occurs: The computer connected to the 
USBMobileHS will beep three times when a Trigger condition is 
first detected.

Buffer Size
You can adjust the size of the recording buffer from 0.4 megabytes to 64 
megabytes. 

The Recording type option determines how this buffer is used. Although 
there are 64 megabytes of physical memory in the Analyzer, the efficiency 
of the recording is about a 2:1 ratio of physical memory to actual USB 
traffic. Shorter USB packets yield a slightly less efficient recording. The 
non-traffic portion of physical memory is utilized for control and timing 
information.

Note: The scale is not linear and affords more granularity in the smaller 
buffer sizes. 

Trigger Position
You can adjust the amount of recording to be done post-Trigger or select 
where you want the Trigger located within the defined buffer. You can 
adjust the Triggering Position between 1 and 99% post-Trigger. Trigger 
Position is available only when Manual Trigger or Event Trigger is 
selected as Recording type.

As an example, if the buffer size is set to 16MB, then for the following 
Trigger Position settings, the amount of pre- and post-Trigger data is

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger

• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger

• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 

• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger

• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

Note: When a Trigger occurs, recording continues until the post-Trigger 
amount of the buffer is filled or when Stop is selected.

Options Name
The Options Name is a descriptive label of the current Recording Options 
settings. Options Names are associated with files that have a .rec suffix. 
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The default option name is default.  Default preserves the current 
Recording Options settings.

The purpose of the Options Name box is to give you a place to preserve 
different Recording Options that you use on a recurrent basis.  For example, 
if you use two or three different Recording Options configurations, you can 
save these configurations and load them the next time they are needed.

Because Options Names are descriptive labels and not file names, you can 
enter in any text you like into the box.  Your labels can be very descriptive 
such as "Trigger on High Speed traffic when CRC errors occur."  

Creating a New Recording Options File 
To create a new Recording Options name, 

Step 1 Enter a comment for the new file in the Options name field.

Step 2 Click Save...

You see the Save As window.

Step 3 Specify a filename (*.rec)

Step 4 Click Save.

Loading a Recording Options File
To load a Recording Options name,

Step 1 Click Load ...

You see the Open window.

Step 2 From the list of .rec files, select the one that represents your 
Options Name.

The options settings for that name then display.

Trace File Name & Path 
Trace File Name & Path opens a Save As dialog box for saving your trace 
file.  The default recording file name is data.usb for Low, Full, and High 
Speed recordings.  

• Click Trace File Name & Path.

You see a Save As… window in which to enter the recording file 
name *.usb for all subsequent recordings.
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5.2  Recording Speed
The Misc tab contains settings that let you to tell the analyzer what speed 
traffic will be running and to configure the analyzer to record On-The-Go 
traffic.  

• On the Go - Check this if you are tracing an On the Go device. This 
allows session request protocol detection. 

• Dual Role Devices:
— 2DRD - If both devices are Dual-Role devices, check this box 

to enable Host Negotiation Protocol (HNP) detection. 

— A Dev Name - Enter a name of your choice to refer to the 
device that receives the mini-a plug. 

— B Dev Name - Enter a name for the device that receives the 
mini-b plug. 

• Assume B is 1st Host - Check this box if your scenario is one 
where the B device is acting as host when the trace is started. If the 
trace incorrectly identifies the wrong host, you can change it when 
viewing it by clicking on the host field of a packet and selecting a 
switch to the other host ID. 
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5.3    Events Recording Options
The Event triggering and filtering options allow you to set specific 
parameters for each Event Group. When an Event Group is selected, a field 
appears that allows you to select specific conditions within the 
corresponding Event Group. As details are selected, other Event Group 
details may become "grayed out" because of limited hardware resources in 
the Analyzer. Information about the resources available is displayed below 
the Event Group details. When a detail is grayed out, it is inactive and 
cannot be selected. If an Event Group remains inactive, the current version 
of the application or BusEngine does not support it.

• Click the Events tab on the Recording Options screen.

You see the Event Groups window:

Packet Identifiers
• Select Packet Identifiers under Event Groups.
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You see the Packet Identifiers window:

The Packet Identifier (PID) field lists the available packet types. Select up 
to three packet types to use as a Recording Trigger. 

Token Patterns
• Select Token Patterns under Event Groups.

You see the Token Patterns window:

Specify up to three combinations of Address/Endpoint with any of the token 
PIDs. They can be triggered on or filtered in/out. 

Frame Patterns
• Select Frame Patterns under Event Groups.
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You see the Frame Patterns window:

Identify frame patterns you want either to filter out of a Trace View or to use 
as a Trigger. You can select either All Start of Frame packets (SOF) to be 
filtered out or specify the Frame Number of a frame to trigger on.

Device Requests
• Select Device Requests under Event Groups.

You see the Device Requests window:

You can select one or two Device Requests for triggering or filtering.

Data Pattern
• Select Data Pattern under Event Groups.
38



USBMobileHS Analyzer User ManualLeCroy SW Version 2.15
You see the Data Pattern window:

Enter a Data Pattern to be triggered upon or click Edit to open a pattern 
editor and enter data on a bit-by-bit basis.

Step 1 Press the Edit button.

You see a Bit-by-Bit window:

Step 2 Click your mouse on the bits within each byte that you wish to edit 
and enter in the appropriate text.  
The Mask and Match fields will change to reflect your changes.
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Bus Conditions
• Select Data Pattern under Event Groups.

You see the Bus Conditions window:

Use any combination of the listed errors as a Trigger.

Errors
• Select Errors under Event Groups.

You see the Errors window:

Use any combination of the listed errors as a Trigger.
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• Bit Stuffing, Frame-Length, CRC, Pid, EOP, Short Byte 
Checkboxes - Select one or more of these errors to set these as the 
basis for triggering or filtering. A Short Byte is a condition where 
EOP begins on a non-byte boundary.

• Time-out or Turn-around Violation - Select this checkbox and 
then enter in the Turn-around time in the text box.  This value tells 
the analyzer how much time should elapse before 
triggering/filtering.  Clocks are 60 MHz (16.66 nS).

• Excessive Empty Frame Detection - Select this option and enter 
the empty frame count in the text box.  This value tells the 
analyzer how many frames should elapse before 
triggering/filtering. 

• Babble Start Violation - Select this checkbox to trigger or filter 
whenever the start of a packet occurs too late in a Frame.

• Babble End Violation (or LOA) -  Select this to trigger/filter 
when the end of a packet occurs too late in a Frame. Enter a value 
in the EOF offset box from 1 to 65,535 clocks to indicate the size 
of the offset from start of previous SOF.

• Bad Data Toggle - Select this checkbox to trigger or filter 
whenever a Data0, Data1, Data2 toggle violation occurs.  

— Select IN or OUT if you only want triggering/filtering to 
occur only on IN or OUT transactions. 

— Check Incl Reset if you want the first toggle value after a 
reset to be considered "good" regardless of the value prior to 
that reset.  If Unchecked, toggle state will be assumed to be 
preserved through the reset.  

— Select Addr and/or Endp to select Token Addresses and/or 
Endpoints.

Transactions
• Select Transactions under Event Groups.
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You see the Transactions window:

Use any combination of the listed errors as a Trigger.

Data Length
• Select Data Length under Event Groups.

You see the Data Length window:

To trigger on data length, enter a value between 0 and 1024 in the box 
marked Data Length.  

Splits
• Select Splits under Event Groups.
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You see the following window.

To trigger on splits, select a split type, and endpoint type, and an address. 
You can also select FS Isoch Out when you select the Isoch endpoint type. 

5.4  Actions Recording Options
The Actions screen serves as a means of setting Triggers, Filters (In or 
Out), and Counts for the events selected in the Events window.  

Actions Window Layout 
The Actions window divides into three sections:  left, center, and right.  

The left section displays buttons for the events selected in the Events 
window.  Events buttons tell USBMobileHS what it should look for during 
a recording.  The number of Event buttons displayed depends on the number 
of  Events selected in the Events window.  If no Events were selected, no 
Event buttons will display.

The right side of the window displays a pair of counters called Count1 and 
Count2.  Counters provide a way for setting triggers based on a passage of 
a certain number of events. When an event is linked to a counter, the counter 
appears below the event on the left side of the screen.  
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The right section displays three Action buttons:  Trigger, Filter Out, and 
Restart.  Action buttons controls USBMobileHS’s response to Event 

conditions.  For example, if an Error button is linked to a Trigger button, the 
Action button tells USBMobileHS to trigger when the error condition 
occurs.

The lines that join the different buttons indicate the links between Actions 
and Events.   

5.5  Connecting Events to Actions
To create or edit links between Event buttons, Counters, and Action buttons, 
you click on an Event button and then click on a Counter or Action.   By 
clicking on an Event, you will cause an arrow to appear that connects the 
Event button to your mouse.  When you click on a Counter or Action button, 
the arrow becomes anchored to the selected button.

To make an association,

Step 1 Select one or more Events from the Events window.

Step 2 Open the Actions window.

Step 3 Click the left mouse button on an Event button such as 
Errors.
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The elastic arrow appears.

Step 4 Point your mouse at the desired Action 
button.

The elastic arrow will move with your mouse 
pointer.

Step 5 With the pointer over an Actions button, click again the left 
mouse button again.

The arrow is anchored to the Action button.  replaced with a black 
line connecting the Event button to the Action button.

5.6  Connecting Counters to Events
The right side of the Actions window contains two Counter 
buttons marked Count1 and Count2.  These counters 
provide a way of triggering after a number of events have passed, such as 
"Trigger after the 20th IN packet."  When an event is linked to a counter, the 

counter appears under that event on the left side of the Actions window. 
Counters have blue dots in their top left corner that provide access to pop-up 
menus.  The menus provide the means of setting the counter value.  The 
counter can be set between 1 and 65,535. 

To connect an event to a counter, 

Step 1 Open the Event window and select an Event.

Selecting an Event will cause an Event button to automatically 
appear in the Actions window. 
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Step 2 Open the Actions window.

The window will display an Event button that is connected to the 
Trigger button on the right via a line.

Step 3 Click the Event button. 

An arrow will appear that will connect the Event button to your 
mouse pointer. 

Step 4 Click one of the two counters.

The Event will automatically connect to the Counter button and then  
connect to the Trigger button.  

Step 5 Click the blue dot in top left corner of 
your selected counter.

A pop-up menu will open.  This menu 
lets you configure the counter.

Step 6 Choose Change Counter Value.

A dialog box will open.

Step 7 Set the counter to a value of your 
choice, then click OK.

The dialog box will close and the 
Counter button will display your 
selection.

Setting Multiple Conditions with Counters
You can create multiple event conditions by linking two counters to two or 
more events.

Linking Two Events to Two or More Counters - If an Event is linked to 
Count1 and a second event is linked to Count2, it creates an "or" statement.  
This statement reads "Trigger when Count1 OR Count2 has reached their 
specified values."
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This example reads "Trigger when Count1 has counted nine Out 
packets or Count2 has counted nine In packets."

5.7  Using Action Buttons
The right section of the Actions window displays three 
Action buttons labeled Trigger, Filter Out/In, and Restart.  

Trigger
The Trigger button enables event triggering.  

Restart
Restart causes counters to restart counting when a certain event occurs.  
When Restart is used there will be at least two links on the screen:   one 
between an Event and the Restart button, and a second between an Event, 
Counter and an Action button.
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The screenshot below gives an example.  The screen below reads "Look for 
IN and Out packets.  When 10 OUT packets, trigger.  However, if an IN 
packet occurs during the count, restart the count."

Filter Out/In
The Filter In/Out button causes events to be filtered in or out of the 
recording.  Filter Out/In toggles between "Filter Out" and "Filter In".

• Filter In records ONLY those packets related to the specified 
event.

• Filter Out records all packets EXCEPT those related to the 
specified event.

Note Only events from the Token, Frame Event, Device Request, and 
Transaction Groups can be used to filter a recording.

To filter in or out Token, Frame Event, Device Request, and/or Transaction 
Group events from a recording, 

Step 1 Click the blue dot on Filter Out.  (Note:  
the button may say Filter In depending on 
the last action specified.)

You see the Filter Out/In menu:

Use this menu to toggle the selection between Filter Out and Filter In.

Step 2 Select "Filter In". 

The button changes to read "Filter In".
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5.8  Saving Recording Options
To complete your Recording Options settings, use the features at the bottom 
of the Recording Options screen. These features remain the same no matter 
which of the three Recording Options screens you are working in.

• Click Save to save the currently specified Recording Options for 
use in future recording sessions. Any file name can be specified, 
though use of the .rec is recommended; if no extension is 
specified, .rec is added by default.

• Click Load to load a previously saved *.rec file, thus restoring a 
previous set of Recording Options.

• The Save as Default function is equivalent to the Save function, 
specifying the file name default.rec. Whenever you start up the 
Analyzer, it automatically loads the default.rec file if one exists.

• Click OK to apply any changes and close this dialog box.

• Click Cancel to cancel any immediate changes you have made 
and exit the Recording Options menu.

5.9  Recording Bus Data
 To start recording USB traffic once the appropriate Recording Options have 
been set perform the following steps.  Note:  If you have inserted any event 
triggers, be sure to select Event Trigger under the General tab in the 
Recording Options dialog box. 

Step 1 Select Start under Record on the Menu Bar

OR

Click  on the Tool Bar.

Your recording session can continue until it has finished naturally or you 
may need to stop manually by clicking  on the Tool Bar, depending on 
how you set the Recording Options.

To manually stop recording,

Step 2 Select Stop under Record on the Menu Bar

OR

Click  on the Tool Bar.

Click  again during the uploading to upload only a portion of the 
recorded memory. 
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Note: The manual Stop Recording feature is primarily of use when 
recording low-speed traffic, which can take a long time to fill the 
recording buffer.

When the recording session is finished, the bus traffic is saved to the hard 
drive as a file named data.usb or whatever name you assign as the default 
filename. 

To save a current recording for future reference,

Step 1 Select Save As under File on the Menu Bar.

OR

Click  on the Tool Bar.

You see the standard Save As screen.

Step 2 Give the recording a unique name and save it to the 
appropriate directory.
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6.  Display Options
Use the Display Options menu to specify the way CATC Trace information 
is displayed.

To open the Display Options menu,

• Select Display Options under Setup on the Menu Bar

OR

• Click  on the Tool Bar 

You see the Display Options window:

Use the General Display Options to specify the basic appearance of a Trace 
View.
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6.1  General Display Options
Use the General Display Options to specify the basic appearance of a Trace.

• Zoom Level: Adjustable in discrete increments from 10% to 
200% percent.

• Enable Tool Tips: Select to enable tool tips with explanation text 
to pop up when you position your cursor over various fields in the 
Trace View.

• Right click cell context menu: This option activates the right 
mouse button so that when clicked it displays pop-up menus in 
the trace. Normally, the left mouse button is used to display 
context-sensitive pop-up menus.

• Navigation Bar: When selected, opens the Trace Navigator 
whenever the software is opened. 

• Wrap: Moves long strings of trace data to the next line so you 
don’t need to scroll sideways to view it. 

• Hierarchy Lines:  Displays lines along the left side of the trace 
window that show the hierarchical relationship between the 
Packets, Transactions, Split Transactions, and Transfers.

• Expand Packet Data Fields by Default: When selected packet 
data fields are expanded whenever the software is opened. 

• Allow any Toggle Value after Bus Reset (Int and Bulk 
Endpoints): When selected any toggle value is allowed after 
resetting the BusEngine. 

• Expand Script-based Decoded Info by default:  Expands by 
default fields using script-based decoding.

• 2-stage SOF Hiding (First click of Hide SOF button hides only 
Empty Frame SOF’s):  Modifies the behavior of the Hide SOF 
button.  If enabled, the Hide SOF button works in two stages.  
Click once to hide all SOFs that begin frames with no USB traffic.  
Click twice to hide all SOFs.

• Display Timestamp at beginning of Packet:  Causes the 
timestamp to reposition from the end of the packet to the front.

• Use New Std Reqs and Descriptors Scripts (for Video Class): 
To support decoding of the Video Class, it was necessary to 
re-write the mechanism by which Standard Requests and 
Descriptors are decoded.  This is because most of the Video 
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configuration information is passed in the Standard 
GET_DESCRIPTOR (Config) descriptor bundle, along with the 
endpoint and interface descriptors, etc.  For non-Video traffic, 
leave this unchecked so the existing Hid, Audio, and other 
descriptors get decoded by the legacy decoder files.

• Trace Viewing Level: Allows packets to be displayed as

— Packets

— Transactions

— Split Transactions

— Transfers

• Fonts: Lets you define the appearance of Field and Data text.

• Display Configuration Name: Provides a comment field that 
serves as a descriptive label for the current Display Options file 
(*.opt). 

Saving Display Options for Future Use
To create a new Display Options file, follow these steps:

Step 1 Enter a comment for the new file in the Display Configuration 
Name field.

Step 2 Click Save...
You see the Save As window.

Step 3 Specify a filename (*.opt).

Step 4 Click Save.
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6.2  Color/Format/Hiding Display Options
Select the Color/Format/Hiding tab in the Display Options window. 
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6.3  Color Display Options
To specify colors in the display, select an item in the Group and Color 
column and make the desired color changes in the color pallet screen.

Use this menu to customize the colors associated with each field in the Trace 
View. You can experiment with this option to achieve the color combination 
best suited to a particular graphic system. A brighter color might be 
appropriate for a specific field that should stand out in the display (e.g. the 
PID Types). 

You can also customize the colors by using the 
options in the Custom tab.
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6.4  Formats Display Options
Select an item under the Group and Color column to enable the formats 
radio buttons in the Format section. The format types changes with respect 
to the item you select under the Group and Color column. For example, if 
you select an item under Packet Fields, you get the following:

The following formats are available:

 Not every format is available for every item.

6.5  Hiding Display Options
To hide one or more fields from the trace, select the 
appropriate item from the Group and Color column, 
click the Hidden checkbox, and click the Save button. 

You can also hide packets and transactions from a trace, 
selecting the desired options from the checkboxes.  You can hide SOFs, 
NAKs, High, Full or Low Speed packets, traffic from one or both recording 
channels, and Address and Endpoint.
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6.6  Level Hiding Display Options
The Level Hiding tab allows you hide whole packets such as Start of Frame 
packets.  Select the Level Hiding tab.

6.7  Saving Display Options 
To complete your Display Options settings, use the features at the bottom of 
the Display Options screen. These features remain the same no matter 
which of the four Display Options screens you are working in.

• Click Save to save the currently specified Display Options for use 
in future sessions. Any file name can be specified, but you must 
use the .opt extension. If no extension is specified, .opt is added 
by default.

• Click Load to load a previously saved *.opt file, thus restoring a 
previous set of Display Options.

• The Save as Default function is equivalent to the Save function, 
specifying the file name default.opt. Whenever you start up the 
Analyzer, it automatically loads the default.opt file if one exists.

• Click OK to apply any changes you have made to Display 
Options and close this dialog box.
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• Click Cancel to cancel any immediate changes you have made 
and exit the Display Options menu.

• Click Apply to apply your changes while keeping the Display 
Options window open.
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7.  Reading a Trace

7.1  Trace View Features
• The USBMobileHS packet view display makes extensive use of 

color and graphics to fully document the captured traffic.

• Packets are shown on separate rows, with their individual fields 
both labeled and color coded. 

• Packets are numbered (sequentially, as recorded), time-stamped 
(with a resolution of 16.67 ns), and highlighted to show the 
transmitted speed (low-speed, full-speed or high-speed).

• Display formats can be named and saved for later use. 

• Pop-up Tool Tips annotate packet fields with detailed 
information about their contents.

• Data fields can be collapsed to occupy minimal space in the 
display (which can in turn be zoomed in and out to optimize 
screen utilization). 

• The display software can operate independent of the hardware 
and so can function as a stand-alone Trace Viewer that may be 
freely distributed.

• High Speed SOFs display Microframes (shown below.)

Microframes
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7.2  Set Marker
You can define a unique Marker for each packet. 

To place a marker on a packet,

Step 1 Left-click on Packet # for the packet you wish to mark.

You see the Packet menu:

Step 2 Select Set Marker.

You see the Edit Marker Comment window where you can enter a 
unique comment about this packet.:

Step 3 Enter your comment. 

Step 4 Click OK.

A marked packet is indicated by a vertical red bar along the left edge 
of the packet # block: 

7.3  Edit or Clear Marker
To clear or edit the comments associated with a packet marker,

Step 1 Left-click on Packet # for the chosen packet.
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You see the Packet menu:

To edit the Marker Comment,

Step 2 Select Edit Marker Comment.

You see the Edit marker comment window:

Step 3 Edit the comment as desired.

Step 4 Click OK.

To clear a Marker,

Step 5 Click Clear Marker.

The vertical red Marker bar disappears.

7.4  View Raw Bits
You can expand a specific packet to view the raw bits in detail. 

To view the raw bits,

Step 1 Left-click on Packet # for the packet you wish to view.

You see the Packet menu:
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Step 2 Select Show Raw Bits. 

You see the Raw Bits View for that  packet:

Along the top of the Raw Bits View is a linear strip of the logical bit 
values with corresponding field demarcations. Bit stuffing is 
displayed in color. Below the logical bit values is a representation of 
the D+/D- signaling complete with NRZ encoding. A scroll bar 
assists in navigation of larger packets. Two buttons under the label 
Packet are used to view previous or next packets.  Two buttons 
under the label Zoom allow you to zoom in or out on packets.

7.5  Expanding and Collapsing Data Fields
You can expand a Data field to view it in greater detail or collapse it 
when you want a more compact view. 

Using the Expand/Collapse Data Field Arrows

Data Fields can be easily expanded or 
collapsed by clicking the small triangular 
arrows on the left side of the data field.

Double-Clicking to Expand/Collapse Data Fields
Data fields can also be expanded or collapsed by double-clicking 
anywhere in the data field.

Expanding or Collapsing All Data Fields
Expand or collapse all data fields by holding down the button for 
more than a second. 
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Using the Data Field Pop-up Menus
Data fields can expanded or collapsed by clicking in a data field and 
selecting Expand Data or Collapse Data from the pop-up menu.

To expand and collapse data using the menu,

Step 1 Left-click on Data in the Data packet you want to expand or 
collapse.

If your Data Trace View is currently expanded, you see the Collapse 
Data menu:

If your Data Trace View is currently collapsed, you see the Expand 
Data menu:

Step 2 Select the desired Expand Data or Collapse Data menu item.

The Trace View is repositioned with the selected packet(s) adjusted 
in the format you have specified.

Expand or Collapse All Data Fields
All data fields can be expanded or collapsed by selecting Expand 
All Data Fields or Collapse All Data Fields from the data field 
pop-up menus.
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7.6  View Data Block
The data field pop-up menu has an 
option for viewing the raw bits in a data 
field.  To view these bits,

Step 1 Click in the data field to open the data 
field pop-up menu.

Step 2 Select View Data Block.

The following dialog box will open. 

The View Data Block window has options for displaying the raw 
bits in different formats:

• Format - Lets you display data in Hex, Decimal, ASCII 
or Binary formats

• Show Per Line - Lets you control how many bits are 
displayed per line

• Bit Order -  Most Significant Bit, Least Significant Bit

7.7  Pop-up Tool-tips
Many fields within the trace will display pop-up tool-tips when the 
mouse pointer is suspended over them.  These tips provide added 
details about the field. 
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7.8  Hide SOF Packets
You can hide Start-of-Frame (SOF) packets that may be 
uninteresting in a given context from a Trace View by clicking the 
Hide SOF Packets button on the Tool Bar:

• Click  to hide all SOF packets.

Note If you have enabled 2-Stage SOF Hiding in the General Display 
Options, then the Hide SOF button works in two stages.  Click once 
to hide all SOFs that begin frames with no USB traffic.  Click twice 
to hide all SOFs.

7.9  Hide NAKs
You can hide NAKs that may be uninteresting in a given context 
from a Trace View by clicking the Hide NAKs  button on the Tool 
Bar:

• Click  to hide all NAK packets.

7.10  Hide Devices
Click the  button to get a window that allows you to select any 
address/endpoint combination to be hidden. 

7.11  Hide Chirps
Click the  button to hide any Chirped-J or Chirped-K packets 
recorded in a USB trace.

7.12  Switch to Transactions View
A Transaction is defined in the USB specification as the delivery of 
service to an endpoint. This consists of a token packet, an optional 
data packet, and an optional handshake packet. The specific packets 
that make up the transaction vary based upon the transaction type. 

The program default display mode is Packet View. Before you can 
view decoded transactions, you must switch from Packet View to 
Transactions View.

To select Transactions View,
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• Click  to on the toolbar.

The Trace View screen is re-drawn to display Transactions.

Note This menu selection will display a checkmark next to Show USB 
transactions when you have selected it. When you want to switch 
back to Packet View mode, right-click anywhere in the trace 
window and then left-click on Show USB transactions.

You can also switch to Transaction View from the Menu Bar:

Step 1 Select Display Options under Setup.
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You see the Display Options General window:

Step 2 Check Transactions.

Step 3 Click OK.
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7.13  View Decoded Transactions
Once you set Display Options, the Trace View screen is re-drawn to 
display decoded transactions in the colors and format you selected.

When you instruct the Analyzer to display USB transactions, the 
components of each transaction are collected from the current 
recording and are grouped and indented below each decoded 
transaction. Each row shows a transaction with a unique numeration, 
a label, and color-coded decoding of important data.

Expanded and Collapsed Transactions
You can expand a specific transaction to view its parts, which are 
grouped and indented below the transaction. 

To expand a transaction,

Step 1 Left-click on the transaction number you wish to view.

You see the Expand Transaction menu:

Step 2 Select Expand This Transaction.

The screen displays the selected transaction in expanded format.
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Note The Expand/Collapse transaction feature operates as a toggle: when 
one format is active, the other appears as an option on the 
Expand/Collapse drop-down menu. 

To collapse a transaction, perform the same operation and select 
Collapse This Transaction. 

Note that you can choose to expand or collapse 

• Only the selected Transaction

OR

• All Transactions.

It is not necessary to use the Expand/Collapse Transactions menu 
to shift between expanded and collapsed views of a transaction: 

• Double-click in the Transaction number field to toggle back and 
forth between collapsed and expanded views.

7.14  Switch to Split Transaction View
To select Split Transaction View,

Step 1 Click the  button on the toolbar.

The Trace View screen is re-drawn to display Split Transactions.

You can also switch to Split Transactions View from the Menu Bar:

Step 1 Select Display Options under Setup.
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You see the Display Options General window:

Step 2 Check Split Transactions.

7.15  Switch to Transfer View
A Transfer is defined in the USB specification as one or more 
transactions between a software client and its function. USB 
transfers can be one of four kinds: Control, Interrupt, Bulk, and 
Isochronous. USBMobileHS is capable of displaying all four types.

The default display mode is Packet View. Before you can view 
decoded transfers, you must switch from Packet View (or 
Transaction View) to Transfer View.

To select Transfer View,

Step 1 Click  on the toolbar.

The Trace View screen is re-drawn to display Transfers.
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Note Selecting Show USB transfers adds a checkmark next to this menu 
item. If you want to return to Packet View, open the menu and 
reselect Show USB transfers. This action will remove the 
checkmark and return the display to Packet View.

You can also switch to Transfer View from the Menu Bar:

Step 1 Select Display Options under Setup.

You see the Display Options General window:

Step 2 Check Transfers.

Step 3 Click OK.
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7.16  View Decoded Transfers
Once you set Display Options, the Trace View screen is re-drawn to 
display decoded transfers in the colors and format you selected.

When you instruct the Analyzer to display USB transfers, the 
components of each transfer are collected from the current recording 
and are grouped below each decoded transfer. Each transfer row 
shows a transfer with a unique numeration, a label, and color-coded 
decoding of important data.

Expanded and Collapsed Transfers
You can expand a specific transfer to view its parts, which are 
grouped and indented below the transfer. 

To expand a transfer,

Step 1 Left-click on the transfer number you wish to view.

You see the Expand Transfer menu:
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Step 2 Select Expand This USB Transfer.

The screen displays the selected transfer in expanded format. 

Note: The Expand/Collapse transfer feature operates as a toggle: when one 
format is active, the other appears as an option on the 
Expand/Collapse drop-down menu. 

To collapse a transfer, perform the same operation and select 
Collapse This USB Transfer. 

Note that you can choose to expand or collapse 

• Only the selected Transfer
OR

• All Transfers.

It is not necessary to use the Expand/Collapse Transfers menu to 
shift between expanded and collapsed views of a transfers: 

• Double-click in the Transfer number field to toggle back and 
forth between collapsed and expanded views.

7.17  Decoding Protocol-Specific Fields in Trans-
actions/Transfers

When transfers or transactions are displayed, the fields in setup 
transactions or control, interrupt, and Bulk transfers by default do 
not get decoded and are shown in hexidecimal values. The 
exceptions are setup transactions and control transfers for standard 
USB device requests which are always decoded.
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In order to show specific decoding for class- and vendor-specific 
device requests and endpoints, you have to use the decoding 
association mechanism that is described in Chapter 9 on decoding. 
When you have performed the association, you will see the 
protocol-specific fields of transfers and transactions decoded in the 
trace view.

7.18  Using the Trace Navigator
You can use the Trace Navigator to show the structure 
of the entire trace from different points on the Trace 
view, thereby refining the trace view to a packet range 
in the trace that is most interesting to you. This range 
can be set by you to show smaller parts of the trace. 

To display the Navigator bar, click  in the 
toolbar or select the Navigation Bar checkbox in the 
Display Options General window. 

The Navigator bar can be repositioned in the trace and 
can be oriented horizontally or vertically, docked or 
undocked by dragging the parallel bars at the top or 
side of the Navigator bar. By default, the Navigator 
bar appears vertically to the right of the trace window.   

The Navigator bar represents different types of trace 
information in the order of the packets. The top of 
each bar corresponds to the first packet in the trace, 
and the bottom corresponds to the last packet. The 
Navigator bar is made up of three parts: Pre and 
Post-Trigger traffic, errors, and types of traffic. 

At any time, a line in the navigator bar of one pixel in 
height represents a fraction of the trace data. If the Navigation bar is 
400 pixels high, then each bar in this example would represent 1/400 
of the trace. If the trace had 4000 packets total, each bar would 
represent ten packets. In the Types of Traffic portion of the 
navigation bar, the color of the bar would be that of the most 
important item in those ten packets. See "Navigator Bar Attributes" 
on the next pages. 
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Drag the square at the top of bottom to set the size of a packet range. 
Drag the entire square to set the packet range to different values. A 
bubble appears showing the packet range while you are setting it. 
Right click on the Navigator to display the pop-up menu. 

• Pre/Post Trigger, Errors, Types of Traffic shows or hides specific 
type of traffic from the Navigator. 

• Set Range to Whole Trace resets packet range to the entire trace.
• Set range near packet number sets the packet range near the packet 

where your mouse pointer is positioned in the Navigator bar. 
• Recently Used Ranges displays a history of ranges that were 

previously selected. 
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Navigator Bar Attributes

The traffic types above are shown in order of importance. For 
example, if a NAK’d transaction occurred in the same sample area 
as a SOF, the NAK would take precedence, and the Navigator would 
show the black bar. 
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8.  Decode Requests

8.1  General Options
Commands are transferred on USB using special control transfers called 
USB Device Requests. The Analyzer can decode Device Requests as they 
are defined in the USB specifications and various Device Class and Vendor 
specifications.

USB Request
Each USB Device Request is sent using a Control Transfer. Each Control 
Transfer starts with a SETUP transaction.

To decode a USB Device Request,

Step 1 Left-click once in the SETUP field of the packet that starts 
the Request.

Note: The menu that appears when you left-click a setup field is 
context-sensitive and may not appear exactly as shown in the next 
few examples.  

If you select Standard Request, you see the Decode Standard 
Request menu:
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If you select Class Request, you see the Decode Class Request 
menu:

If you select Vendor Request, you see the Decode Vendor Request 
menu:

Decoding Standard Requests
When you select Decode Standard Request, you see a window displaying 
the decoded Standard Request:

Shown here is a GET_DESCRIPTOR Standard Request.
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Decoding Class Requests
When you select Decode Class Request, you see the Decode Class 
Request drop-down menu:

The drop-down menu lists the Classes whose definitions are contained in the 
Analyzer.

Step 1 Select the Class which agrees with the Setup Address 
selected.

You see a Decode Request screen (similar to the one below) that 
provides you with definitions for the individual fields of the Request 
and the returned data:

Shown here is a sample GET_STATUS Hub Class Request.

Decoding Vendor Requests
Decoding a Vendor Request is the same as decoding a Class Request except 
that you use Vendor Request definitions rather than Class Request 
definitions.
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Decoding USB Requests

When your Decoding request does not belong to any of the defined 
Decoding groups (Standard, Class, or Vendor), 

• Select Decode USB Request from the Request menu.

You see the USB Decode Request screen.

This screen provides definitions for the individual fields of the Request and 
the returned data.

Class and Vendor Definition Files
LeCroy analyzers use script files to decode class and vendor requests.  
These script files are read when the application is initialized.  Once read, the 
analyzer then decodes class and vendor requests as instructed by the files.

.REQ Files and .DSC Files - Represent the old method of decoding.  .REQ stands 
for Requests and .DSC stands for Descriptors.  This method was originally 
developed for some of LeCroy’s earlier USB analyzers and uses uses fixed 
definitional structures.  LeCroy provides .req files for the following 
requests and classes:

• Standard Requests (standard.req) (Not used with Video Class 
decoding)
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• Hub Class (hub.req) (No longer used: replaced by Script 
Decoder version .dec files)

• HID Class (hid.req)

• Printer Class (printer.req)

• Communications Class (communication.req)

• Audio Class (audio.req)

• Bluetooth USB HCI commands and events (bluetooth.req)  
(No longer used: replaced by Script Decoder version .dec files)

• The Analyzer also includes a sample of a Vendor Request 
definition file (vendor.req). 

To add your own .req file for a Class or Vendor Request, 

Step 1 Use Notepad to create and edit your own Request Definition file (for 
example, my_vendor_commands.req).

Note To learn to write such a file, review the Request (.req) files 
provided by LeCroy.

Step 2 Add the name of your Request file to the request.lst file.

Step 3 Click Setup.  The decoding menu in the Class/Vendor List appears.

.DEC Files - Represents the new method of decoding.  This method is more 
powerful than the old and uses a C-like language.  .DEC stands for 
"decoder" and describes both Class and Vendor requests. 

.DEC files are found in the Scripts directory under the application directory.  
Each .dec file stores an endpoint or request decode.  When the application 
starts, these files are loaded dynamically.  Subdirectories are supported.

The following .dec files are provided: 

• Bluetooth HCI

• Hubs

• Mass Storage

• Still Image/PTP

• Video

If desired, you can create your own .dec file for a Class or Vendor Request.

For more information on the format of these Script Decoder files and the 
Script Decoding language, read the Script Decoder Manual.
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Note If Video is selected, the Display Options need to be set to "Use 
new Std Reqs & Descriptors Scripts (for Video Class)" for 
video.  The file VideoCurrentEntityIdMap_EditMe.inc in the 
VideoClass directory will also need to be edited.  You will be 
assigning entity IDs to corresponding Control types.  The 
instructions are in that file.

8.2  Class/Vendor Decoding Options
This interface allows you to permanently assign a class or vendor decoding 
for an address and/or endpoint or interface in a Trace file. Once assigned, 
the decoding occurs automatically when you choose to display transactions. 
You see the Decode Class menu for whichever Class type you have selected.

Request Recipient to Class/Vendor Decoding
To assign a decoding group to a request recipient, 

Step 1 Left-click once in the packet’s SETUP field.

You see the Decode Request menu:
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Step 2 Select Request Recipient to Class/Vendor Decoding.

You see the Request Recipient window:

The Request Recipient field shows all the USB Class and Vendor Request 
Recipients found in the Trace file. Displayed on the right are the names of 
Class/Vendor decoding groups currently assigned to recipients. If no 
decoding is assigned for a recipient, nothing is displayed next to the address. 
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To select a recipient for which to assign or modify its Class/Vendor 
decoding,

Step 1 Display the Class/Vendor Decoding Groups drop-down 
menu.

The drop-down menu lists the defined Class/Vendor request 
decoding groups. 

Step 2 In the Request Recipient field, highlight a Recipient.

Step 3 From the Class/Vendor Decoding Groups drop-down 
menu, select the decoding group you want to assign to the 
highlighted Recipient 

OR 

Select No Decoding if you do not want any specific decoding.

Step 4 Repeat the previous step for any additional recipients you 
would like to map.

Step 5 Click OK.

Class/Vendor Endpoint Decoding
Some usb endpoints can transfer formatted data that is defined in various 
device class or vendor specifications. 

USBMobileHS provides the same decoding capabilities for data sent on 
endpoints as for device requests. You can define decoding for endpoints by 
adding EndpointData construct to your .req file (see examples in hub.req 
and bluetooth.req.)
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To assign a Class/Vendor Endpoint decoding, 

Step 1 Left-click once in the packet’s IN or OUT field.

You see the following menu.

Step 2 Select Request Recipient to Class/Vendor Decoding

You see the Request Recipients and Endpoints dialog box.

Step 3 Click on the tab marked Endpoints.

You see the Endpoints dialog box.

The Endpoint field shows all the Endpoints found in the Trace file. 
Displayed on the right are the names of Class/Vendor Decoding that are 
currently assigned to Endpoints.
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To select an endpoint for assigning or modifying its Class/Vendor decoding,

Step 1 Display the Class/Vendor Decoding Groups drop-down menu

You see the Class/Vendor Endpoint Decoding drop down menu.

Step 2 In the Endpoint field, highlight an address, Endpoint, and 
Field.

Step 3 From the Class/Vendor Endpoint Decoding drop-down 
menu, select the type of decoding you want 

OR 

Select No Decoding if you don’t want any specific decoding.

Step 4 Repeat the previous step for any additional endpoints you 
would like to map.

Step 5 Click OK.

To decode

Step 1 Left-click the field marked IN or OUT. You will see the 
following or similar menu:
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Step 2 Select Decode as Hub Status Change Endpoint

A text box will open that will display the Hub Status Change Endpoint.
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9.  Other Features

9.1  Search
The Search feature provides several options for searching through recorded 
traffic, allowing you to find specific packets based on triggering status, 
packet number, marking, or content. 

To view the Search options,

• Click Search in the Menu bar.

You see the Search drop-down 
menu:

Go to Trigger

Note: Go to Trigger is enabled only when a 
trigger has created the traffic file.

To display a Trigger Event,

• Select Go to Trigger under Search on the Menu Bar.

The Trace View is repositioned to the first packet following the 
Trigger event.  This packet will be at the top of the screen.

Go to Packet/Transaction/Transfer ...
To display a specific packet,

Step 1 From the menu bar, select the command 
Search > Go to Packet/Transaction/Transfer

You see the Go to Packet window:

Step 2 Select the desired viewing level (packet, transaction etc.) from the 
drop-down menu next to the words Go to.
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Step 3 Enter the number of the packet you want to display.

Step 4 Click OK.

The Trace View is repositioned with the selected packet at the top of 
your screen.

Go to Marker
To instruct the Analyzer to display a marked packet,

Step 1 Select Go to Marker under Search on the Menu Bar.

You see a drop-down menu listing the marked packets in that Trace 
View:

Step 2 Select the desired packet from the displayed list.

The Trace View is repositioned with the selected packet at the top of 
your screen.

Note: The Go to Marker feature functions in conjunction with the Set 
Marker feature. The comments within the parentheses following 
each marked packet are added or edited with the Set Marker 
feature. Please refer to Set Marker in Reading a CATC Trace.

You can use Ctrl+M to go immediately to the All Markers dialog. 

Go To
The Go To feature takes you directly to an event in a Trace.

Step 1 Select Go To under Search on the Menu Bar.
90



USBMobileHS Analyzer User ManualLeCroy SW Version 2.15
You see the Go To drop-down menu:

Step 2 Select the event you want to go to and enter the necessary 
information.

Packet IDs (PIDs)

Select the type of packet you want to go to.

ANY Error
Repositions the trace to show the next instance of any error.
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Errors
The Errors menu allows you to search for five different types of error:  PID, 
CRC5, CRC16, Packet Length, and Stuff Bits.  Menu items will appear in 
bold if they are present in the trace or grayed out if not present in the trace 
as shown in the example below.

You can press Shift+E to go to the first error of any type. 
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Data Length
Allows you to search for data packets of particular lengths.  Lengths are 
displayed in Bytes in a drop down menu as shown below.  Selecting a length 
will cause the display to move to the next instance of that packet length.

Addr & Endp
The Addr & Endp feature allows you to search for the next packet which 
contains a particular address and endpoint.  All available address endpoint 
combinations will be displayed in the pull down menu.
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Bus Conditions
Allows you to search by bus conditions such as traffic speed, reset, and 
suspend.  All available bus conditions are displayed in the pull down menu.
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Split HubAddr & Port
Allows you to search by Hub Address and port.  If present, the option 
"More ..." opens a dialog box with a list of addresses and ports. 

On-the-Go
Allows you to search for On-the-go attributes.  The On-the-Go sub-menu 
contains entries for:

HNP - Host Negotiation Protocol

SRP - Session Request Protocol

Host : A - Hosts with an A plug

Host:  B - Hosts with a B plug   
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Channel
Allows you to search for traffic by 1 (Classic-Speed) or 0 (Hi-Speed).

Find
Find allows searches to be conducted on an open trace using one or more 
criteria.  You can search by packet, transactions, split transaction, transfer, 
by packet type and by fields within packets.  

Find is run by selecting Search >Find or by clicking on the toolbar.  

Searches can combine criteria using the options Intersection and Union.  
Intersection creates AND statements such as "Find all packets with x and 
y."  Union creates OR statements such as "Find all packets with x OR y."

You can also perform searches whereby packets or events are excluded from 
a trace.  The Exclusion allows searches to be conducted.

To perform a search,

Step 1 Select Find... under Search on the Menu Bar

OR

Click  in the Tool Bar.
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You see the User-Defined Find Events screen:

Step 2 Select Packet, Transaction, Split Transaction, or Transfer from 
the top left list box.

Your choice will affect the options presented in the Events Group 
box.

Step 3 Select one or more events from the Events Group box.

Step 4 Select one of the following options:

• Union: Find all packets matching ANY of the specified events. 

• Intersection: Find packets matching ALL of the specified events.   

• Exclusion: Exclude packets matching any of the specified events.  

Exclusion works with the other two options:  Select Union AND 
Exclusion (=Exclude packets with ANY of the following fields) 
or  Intersection AND Exclusion (=Exclude packets with ALL of 
the following fields.) 
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Step 5 If desired, set the search Direction and Origin.

Step 6 Click OK.
After the search finishes, the packets meeting the search criteria will display.

Find Next
To apply the previous Find parameters to the next search,

• Select Find Next under Search on the Menu Bar

OR

Click  on the Tool Bar.

Search Direction
Toggles the search forward or backwards.  The current direction is indicated 
in the menu.

9.2  Edit Comment
You can create, view, or edit the 100-character comment field associated 
with each Trace file. These comments will be visible in the Windows 
Explorer if the "Comments" attribute is included in the Details view. 

Step 1 Select Edit Comment under File on the Menu Bar.

You see the Edit comment for trace file window:

Step 2 Create, view, or edit the comment.

Step 3 Click OK.

You can view comments in Windows File Explorer by selecting the 
"Comments" attribute. 
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9.3  Reports
The Report menu provides several reports to assist you in analyzing USB 
traffic recorded by the Analyzer.

File Information
To display a File Information report,

• Select File Information under Report in the Menu Bar

OR

Click  in the Tool Bar.

You see the File Information screen:

The File Information report provides information about how the recording 
was made, what the buffer settings were, what the trigger options were, and 
what version of all the Analyzer hardware was used to make the recording.

Error Summary
The Error Summary details all errors analyzed throughout the recording.

• Select Error Summary under Report in the Menu Bar
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OR

Click  in the Tool Bar.

You see the Error screen below the Trace View:

Timing Calculations
The Timing Calculator is used to measure timing between any two packets.

• Select Reports > Timing Calculations in the Menu or click .

You see the Timing and Bus Usage Calculator screen: 

Traffic Summary
Traffic Summary summarizes the numbers and types of packets, 
transactions etc. that occurred in the open trace.
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To run Traffic Summary, select Report >Traffic Summary or click the 
button marked  .  You will be prompted to specify a range of packets, 
then be shown the following window:
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Bus Utilization
The Bus Utilization window displays information on bandwidth use for the 
three recording channels.  

To open the Bus Utilization window, select Report >Bus Utilization or 
click the button marked  .  A window will open with two graphing areas:

Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of 
the displayed data and for exporting data:

The buttons have the following functions:

Save As - Saves the graphs 
as a bitmap file (*.bmp) Vertical zoom in

Email - Creates an email 
with a *.bmp file attachment 
of the graphs

Vertical zoom out

Print

Click and Drag zoom - Click diagonally to 
select and zoom in on part of the graph

Full Screen Select Range

View Settings - opens a 
sub-menu with options for 
formatting the display.  See 
“View Settings Menu” 
below.

Sync and Graph areas - If two or more 
graphs are displayed, this button will 
synchronize the graphs to one another.  Once 
synchronized, the positioning slider of one 
graph will move the other graphs
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View Settings Menu
Clicking the View settings button  causes a menu 
to open with options for formatting the display.

• Orient Horizontally - changes the 
orientation of bus usage to horizontal.  
After selecting this option, the menu will 
say "Orient Vertically."

• Tile Vertically - tiles the two graphs 
vertically (i.e., side by side).

• Show Markers - Places "tick" marks along 
the x axis of each graph.

• Show Plumb Line - 

• Status - Opens a sub-menu with the following options:

— Bar - Displays a status bar at bottom of graph.

— Tooltip - Causes a tooltip to appear if you position your mouse 
pointer over part of the graph and leave it there for a couple of 
seconds.

— None - Turns off tooltips and the status bar.

• Grid Lines - Opens a sub-menu with the following options:

— Both - Displays both X and Y axis gridlines

— X Axis - Displays X axis gridlines

— Y Axis - Display Y axis gridlines

— None - Turns off gridlines

• Grid on Top - Moves the grid lines above the graph.

Horizontal zoom in

Graph Areas - Presents options for 
displaying additional graphs of data lengths, 
packet lengths, and percentage of bus 
utilized.

Horizontal zoom out
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• Fonts and Colors - Opens a dialog box for setting the colors and 
fonts used in the graphs:

Graph Areas Menu
The Graph Areas menu allows you to view different information in the Bus 
Utilization window. 

Step 1 Click the button.

The Graph Areas menu opens. 

Step 2 Select the data you want to appear in the Graph Areas 
window. 

To change the properties in the Bus Utilizations graph, follow these steps:

Step 1 In the Graph Areas menu, select what you want your graph 
to display. 
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Step 2 Click OK.

Or
To make a new graph, click New.
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How to Contact LeCroy

Limited Hardware Warranty
So long as you or your authorized 
representative ("you" or "your"), fully 
complete and return the registration card 
provided with the applicable hardware product 
or peripheral hardware products (each a 
"Product") within fifteen days of the date of receipt from LeCroy or one of its 
authorized representatives, LeCroy warrants that the Product will be free from 
defects in materials and workmanship for a period of three years (the "Warranty 
Period").  You may also complete your registration form via the internet by visiting 
http://www.catc.com/support/register/.  The Warranty Period commences on the 
earlier of the date of delivery by LeCroy of a Product to a common carrier for 
shipment to you or to LeCroy's authorized representative from whom you purchase 
the Product.

What this Warranty Does Not Cover
This warranty does not cover damage due to external causes including accident, 
damage during shipment after delivery to a common carrier by LeCroy, abuse, 
misuse, problems with electrical power, including power surges and outages, 
servicing not authorized by LeCroy, usage or operation not in accordance with 
Product instructions, failure to perform required preventive maintenance, software 
related problems (whether or not provided by LeCroy), problems caused by use of 
accessories, parts or components not supplied by LeCroy, Products that have been 
modified or altered by someone other than LeCroy, Products with missing or altered 
service tags or serial numbers, and Products for which LeCroy has not received 
payment in full.

Type of Service Contact
Call for technical support… US and Canada: 1 (800) 909-2282

Worldwide: 1 (408) 727-6600
Fax your questions… Worldwide: 1 (408) 727-6622
Write a letter… LeCroy

Customer Support
3385 Scott Blvd.
Santa Clara, CA 95054

Send e-mail… support@catc.com
Visit LeCroy’s web site… http://www.lecroy.com/
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Coverage During Warranty Period
During the Warranty Period, LeCroy or its authorized representatives will repair or 
replace Products, at LeCroy's sole discretion, covered under this limited warranty 
that are returned directly to LeCroy's facility or through LeCroy's authorized 
representatives.

How to Obtain Warranty Service
To request warranty service, you must complete and return the registration card or 
register via the internet within the fifteen day period described above and report 
your covered warranty claim by contacting LeCroy Technical Support or its 
authorized representative.  

You can reach LeCroy Technical Support at 800-909-7112 or via email at 
support@catc.com.  You may also refer to the LeCroy website at 
http://www.lecroy.com for more information on how to contact an authorized 
representative in your region.  If warranty service is required, LeCroy or its 
authorized representative will issue a Return Material Authorization Number. You 
must ship the Product back to LeCroy or its authorized representative, in its original 
or equivalent packaging, prepay shipping charges, and insure the shipment or 
accept the risk of loss or damage during shipment. LeCroy must receive the Product 
prior to expiration of the Warranty Period for the repair(s) to be covered.  LeCroy 
or its authorized representative will thereafter ship the repaired or replacement 
Product to you freight prepaid by LeCroy if you are located in the continental 
United States.  Shipments made outside the continental United States will be sent 
freight collect.

Please remove any peripheral accessories or parts before you ship the Product. 
LeCroy does not accept liability for lost or damaged peripheral accessories, data or 
software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new 
and/or reconditioned parts, at its sole discretion, made by various manufacturers in 
performing warranty repairs. If LeCroy repairs or replaces a Product, the Warranty 
Period for the Product is not extended.

If LeCroy evaluates and determines there is "no trouble found" in any Product 
returned or that the returned Product is not eligible for warranty coverage, LeCroy 
will inform you of its determination.  If you thereafter request LeCroy to repair the 
Product, such labor and service shall be performed under the terms and conditions 
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of LeCroy's then current repair policy.  If you chose not to have the Product repaired 
by LeCroy, you agree to pay LeCroy for the cost to return the Product to you and 
that LeCroy may require payment in advance of shipment.
General Provisions
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU 
MAY HAVE ADDITIONAL RIGHTS THAT VARY BY JURISDICTION.  
LECROY'S RESPONSIBILITY FOR DEFECTS IN MATERIALS AND 
WORKMANSHIP IS LIMITED TO REPAIR AND REPLACEMENT AS SET 
FORTH IN THIS LIMITED WARRANTY STATEMENT. EXCEPT AS 
EXPRESSLY STATED IN THIS WARRANTY STATEMENT, LECROY 
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES FOR ANY 
PRODUCT INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF AND CONDITIONS OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, AND ANY WARRANTIES THAT 
MAY ARISE FROM ANY COURSE OF DEALING, COURSE OF 
PERFORMANCE OR TRADE USAGE.  SOME JURISDICTIONS MAY NOT 
ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, 
SO THE PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET 
FORTH IN THIS LIMITED WARRANTY STATEMENT OR FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES INCLUDING, WITHOUT 
LIMITATION, ANY LIABILITY FOR THIRD PARTY CLAIMS AGAINST 
YOU FOR DAMAGES, PRODUCTS NOT BEING AVAILABLE FOR USE, OR 
FOR LOST DATA OR SOFTWARE.  LECROY'S LIABILITY TO YOU MAY 
NOT EXCEED THE AMOUNT YOU PAID FOR THE PRODUCT THAT IS THE 
SUBJECT OF A CLAIM.  SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE PRECEDING EXCLUSION OR LIMITATION MAY NOT 
APPLY TO YOU.

The limited warranty on a Product may be transferred for the remaining term if the 
then current owner transfers ownership of the Product and notifies LeCroy of the 
transfer.  You may notify LeCroy of the transfer by writing to Technical Support at 
LeCroy, 3385 Scott Blvd., Santa Clara, CA 95054 USA or by email at: 
support@catc.com.  Please include the transferring owner's name and address, the 
name and address of the new owner, the date of transfer, and the Product serial 
number.
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Index

A
Actions

action buttons 55
recording options 51

Addr & Endp search criteria 103
Alert, beep 38
Analyzer, resetting 21
Application startup 23
Architecture of system 7
Auto Merge trace files 39
Automatic updates 17
B
Beep when trigger occurs 38
Bit-by-Bit window 46
Buffer size 39
Bus Conditions 46, 104
Bus data, recording 58
Bus Utilization 112
BusEngine

updating 16
Buttons

action 55
bus utilization 112
navigator 86
real-time statistics 116
tool bar descriptions 29

C
LeCroy Support 119
CATC Trace

set marker 71
Channel

search 105
trigger/filter 39

Class definition file 92
Class request, decode 90

Class/vendor decoding 93, 95
Clear marker 72
Clock selection 42
Collapse. See also Expand

collapse data fields 74
collapsed transactions 80
collapsed transfers 84

Colors in Display Options 64, 65
Comments, editing 107
Complex search 106
Components 3
Components, physical 4
Connecting

counters to events 53
events to actions 52

Contacting LeCroy 119
Context-sensitive help 24
Counters

changing values 54
connect to events 53
setting multiple conditions for 54

D
Data block, viewing 76
Data fields

expand/collapse 74
pop-up menus 75

Data length
in event groups 49
search for 103

Data pattern 45
Decode

class request 90
decoding class/vendor 95
decoding descriptors 92
decoding options 93
general options for requests 89
hub status 98
protocol-specific fields 85
request recipient 94
standard USB request 89
vendor request 91

Decoded transactions, viewing 79
Decoded transfers 84
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Default settings 11
Device requests 45
Direction of search 107
Display

configuration name 62
display windows 25

Display Options
color/format/hiding 64
general 62
level hiding 68
saving 68

Display resolution 9
E
Editing

data patterns 46
edit comment 107
edit marker 72, 73

Endpoint
decoding 95

Errors
error summary 109
in event groups 47
searching for 102
types of 47

Events
connecting to counters 53
connection to actions 52
event groups 43
event trigger 38
in Recording Options 42

Expand. See also Collapse
data fields 74
expanded transactions 80
expanded transfers 84

Extern Data7, Data0 In 50
External

external input signals 48
external interface signals, saving 39
external output signals 56

F
F1 help 24
Features

product 4
trace 12

Files
class and vendor, decoding 92
editing comment for trace 107
file information 108
filename of trace 40
information 108

Filter Out/In button 55
Filtering events 42
Find 106
Find Next 107
Firmware

automatic updates 17
manual updates 20

Fonts, changing 62
Format

in display options 66
Frame patterns 44
G
General Display Options 62
General Recording Options 38
Go to

Go to 100
Go to Marker 100
Go to Packet/Transaction/Trans-

fer... 99
Go to Trigger search 99

Graphs
displaying multiple 117
Graph Areas menu 114

H
Hardware installation 9
Help

context sensitive (F1) 24
Help menu 27

Hiding
in display options 67
levels 68
NAKs 77
SOF packets 77
toolbars 27
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High-pulse signals 56
HNP 105
Host computer requirements 8
Hosts

Host Negotiation Protocol 105
with a B plug 105
with an A plug 105

Hot keys 33
I
Initial USB recording 10
Input signals, external, external 48
Installation 9
Intersection search 107
K
Keyboard shortcuts 33
L
Layout of Actions window 51
License 119
Linking events 54
Low pulse signals 56
M
Manual trigger 38
Manual updates 20
Markers

clearing 72
editing 73

Memory requirements 39
Menus

graph areas 114
pop-up 62
pull-down 25
real-time statistics 117
view settings 113

Merging trace files 59
Mini A-B plugs 8
Misc tab in recording options 41
Monitor resolution 9
Monitoring statistics 115
N
NAKs, hiding 77
Name of settings 40

Navigation tools 33
Navigator 86
Navigator bar 86
O
On the Go, searching 105
Output signals, external 56
Overview of software 23
P
Packets

display level 62
hiding SOF 77
packet identifiers 43
searching for IDs 101
view features 12

Partial Upload 31
Percentages, post triggering 39
Physical components 4
Physical memory 39
Plugs, mini A-B 8
Pop-up menus

data field 75
enabling 62

Pop-up tool tips 76
Ports for testing 8
Position of trigger 39
Post triggering percentages 39
Product specifications 6
Program startup 23
Protocol-specific fields, decode 85
Pull-down menus 25
Pulse toggle signals 56
R
Raw bits, viewing 73
Real-time statistics 115, 117
Recording

activity 32
bus data 58
progress 30
snapshot 38
speed 41
status 31
type 38, 39
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Recording Options
default settings 11
events 42
general 38
options name 40

Report menu 26
Reports 108
Requirements for PC 8
Resetting the Analyzer 21
Resolution, display 9
Restart button 55
Revisions, software/firmware 15
S
Save

Display Options 68
external interface signals 39
recording options 57
Save As 40
trace files 40

Search
complex 106
direction 107
feature 99
menu 26
status 32

Session Request Protocol 105
Set marker in trace 71
Setup menu 25
Signals

external input 48
external output 56

Slow clock selection 42
Snapshot recording 38
SOF packets, hiding 77
Software

installation 9
updates 16

Specifications 6
Speed of recording 41
Split transaction view 81
Splits, in event groups 50
SRP 105
Starting

software 23
Statistics, monitoring 115
Status bar 30
Summary

error 109
traffic 111

System
architecture 7
components 3

T
Technical Support 119
Test ports 8
Timing calculations 109
Toggle signals, pulse 56
Token patterns 44
Tool bar

button descriptions 29
resetting 27

Tool tips 24, 62, 76
Trace

first recording 12
Navigator 86
recording 10
set marker in 71
view features 12, 71
viewing level 62

Trace files
auto merge 39
edit comment 107
filename 40
merging 59

Trace Navigator 86
Traffic

recording 10
summary 111

Transaction view 77
Transactions

decoded 79
decoding protocols 85
expanded/collapsed 80
in event groups 48
split view 81

Transfer view 82
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Transfers
decode protocols 85
decoded 84
expanded/collapsed 84

Triggers
Manual and Event 38
trigger button 55
trigger position 39
trigger/Filter channel 39
triggering events 42
using errors for 47

Truncate Data Fields 38
U
Union search 107
Updates

automatic 17
BusEngine/Firmware 16, 17
manual 19, 20
Software 16

Upload, partial 31
USB

decode requests 89
recording traffic 10
test ports 8

USBMobileHS connection 7
V
Vendor

decode request 91
definition files 92

View
data block 76
decoded transactions 79
decoded transfers 84
menu 26
options 27
raw bits 73
split transaction 81
transaction 77
transfer 82

W
Warranty and License 119
Window layout, actions 51

Window menu 27
Wrap 33, 62
Z
Zoom in/out 33
Zoom level, adjusting 62
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